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Chapter 1

Euterpe

1.1 main

Contents

Welcome in Euterpe help. Select the subject of interest with a click in the matching button.

Introduction -- Presentation of the software

Features -- Technical details

Registration -- How to register ?

Translation -- How to translate Euterpe ?

History -- The modifications

Thanks -- Those who helped me

Translators -- Euterpe’s translators

Author -- Contacting me

Tutorial -- Learning how to use Euterpe

Installation -- How to install Euterpe ?

Using Euterpe with 2.0 -- 3.0 differences

The MIDIFILEs -- format description

GM/GS/XG formats -- The MIDI standards

Options -- Options list

The tracks -- How to create tracks ?

The patterns -- How to create patterns ?

Creating a MIDIFILE -- How to do this ?

Recording MIDI -- Recording notes

Recording Audio -- Recording sounds

MultiTracks recording -- Recording more than one track

The Instruments -- Customize your tracks

Midi Setup -- CAMD.library and serial.device

Audio Setup -- Using AHI
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Questions and Answers -- Additional informations

Reference Guide -- Operations detail

The screens -- The utility of screens

The windows -- Description

Background -- Software control

Tracks -- Tracks & patterns edition

Track creation -- Type selection

Track parameters -- Settings

Pattern parameters -- Settings

Instruments -- Edition

Instruments parameters -- Settings

MIDI -- Program Change

Drum -- Drum Elements

Audio -- Program Change

Drum Audio -- Drum Elements

Texts -- Sentences

Pictures -- Graphics

ARexx -- ARexx scripts

Patterns edition -- The windows types

2D Edit -- Bars edition

Events -- List edition

Control -- Tapedeck controls

EMusic Console -- ARexx commands access

Keyboard shortcuts -- Fast access to functions

ARexx commands -- Defining macros

Index -- Seeking keywords

1.2 caracteristiques

Features

Euterpe is a multimedia sequencer

Detailed features are :

Recognised file formats :

For songs : MidiFile type 0 and 1, SMUS (read only), ProTracker and ETSF (specific IFF format)

For the sounds : AIFF, IFF 8SVX, Sonix (TM) .ss, IFF SNDP & EWAV (specifics) and DataTypes. ProTracker sounds are loaded
with their module.

For the pictures IFF ILBM and DataTypes

Genlocks Support

Unlimited tracks Tracks Types : Instrument for the notes, Samples for the sounds, Master for global events.
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Unlimited patterns on tracks

Patterns types for instruments tracks : Channel, Common and SysEx

Instruments types : Midi, Midi Drum, Audio, Audio Drum, Texts, Pictures and ARexx

Recognise formats General MIDI and Roland GS

Knows most constructors sysex codes and most Control Changes by name.

Events Editor and Bar Editor

Sample Editor with Fast Fourier Transformation option for sound frequency calculation

Midi Test functions (notes, programs and banks)

Synchronization Midi Time Code, TimeClock and by sampling

Metronome

Midi Mixer

Midi Effects

ARexx macros definitions

Multifiles : Up to 10 songs can be used simultaneously

Display sensitive to fonts and supports all resolution starting with 640x200, 4 colors

Midi Access via devices or CAMD.library (optional).

Audio Access using AHI.device (required)

ARexxPort

Public Screen

Internal resolution from 96 to 768 pulses per quarter note (192 is default)

Supports external controler via Joystick port

Master Track allowing tempo and signature changes

Knows latin, english and german writings for notes

Multi-tasking

Use realtime.library, allowing a real pause when playing

Looping modes, using two locators

AppWindow and AppMenuItem

Localisation

Online Help and Menu Help

1.3 enregistrement

Registration

Legal Informations

Euterpe is Copyright © 1992-1998, Dominique Lorre

This product is distributed as SHAREWARE.

This software is limited in its functionalities (limitations detail vary between software versions) and will only be fully operational
by the add of a key file.

This file can be obtained by registration.

You are authorised to distribute this software in its original form, included on networks and on magazines disks or CD-ROM
without restriction. The distribution by any mean of the keyfile is prohibited.

To obtain your personal keyfile, simply fill and sign the registration form, and follow the instructions.
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1.4 localisation

Localisation

Euterpe contains more than 700 lines to translate

To make a new catalog for Euterpe you can follow the following method:

Ask me before. May be somebody else has started the job and your work will be fruitless. In the other hand, you could work in
a team.

Look closely at the files Euterpe.cd and Euterpe_français.ct which are join with Euterpe’s distribution. These are CatComp’s
files and you should be used with this utility before going on.

Euterpe is particular from the other software because the CatComp files are automatically generated by a special version of the
executable file. Practically this mean that non translated texts will appear in the ct file at each new version of Euterpe.

The name of the messages is globally politically correct ;) :

All begin by MSG_

_MENU indicates a menu title

_REQ indicates a requester message

_GAD indicates a gadget label, ’_’ character is for underlining

_ERR is for an error message

_FMT is for sprintf formatted strings. Arguments order can not be specified for now, since there are some floating point formats
inside these strings.

The .guide file is demanding more efforts, that’s why you could be two. Further more, you will need the translated catalog, so
you can use the terms that you can see when using the software. Nodes names need not and MUST NOT be translated. They
need not because they do not appear on display and MUST NOT because the software will not find same back when the user ask
for menu help.

1.5 merci

Thanks

Here are those who helped me in the development of Euterpe

Rob Peck, for his audiotools routines

Christian Braut, for his great Midi Book (Livre d’Or de la Norme Midi)

Martin Blom for AHI

Jérôme de Solliers, a good Beta-Tester

Nelson Barata, for his tests

Olaf Olsen Barthel, for his ratio calculation routine in GhostScript, the only one which made what I wanted to.

Tallin, for CAMD.library

Tony Racine, from HiSoft, for his trust at a time where the software was very unstable

Douglas Walker, from SAS, to have continuously enhanced his compiler

Amiga News and Amiga Concept magazines, for moral support

Antoine Grimaldi, for his SMPTE synchro box

If you are in this list, just contact me to obtain a free registration.
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1.6 auteur

Author

My coordinates

Dominique Lorre

Le Fabary, BAT C

4, Allée des Peupliers

13100, Aix-en-Provence FRANCE

EMail: dlorre@caramail.com

1.7 translators

Euterpe’s translators

Here are those who have translated Euterpe

german: Dirk Neubauer (neubauer@rz.uni-greifswald.de)

Sönke Tesch (soenke.tesch@elmshorn.netsurf.de) [Proofreader]

english: Dominique Lorre (dlorre@caramail.com)

french: Dominique Lorre (dlorre@caramail.com)

czech: Ondrej Zima (homolka@terminal.cz)

Vit Sindlar (sindlar@jackal.cis.vutbr.cz) [Proofreader]

hungarian: Csaba Molnar (mocsa@eik.bme.hu)

1.8 historique

History

Modifications bringed to the software

Version 1.10 -- first public version

Version 1.10 (7.08.97)

Minor correction mineure bringed to ToolTypes parsing : the default size of the fonts was 8 instead of the Preferences size.

New Installer script. The previous one was creating a path entry for Euterpe instead of an Assign in the S:User-Startup file.

Changes in the tooltypes of icon Euterpe.info, previous ones were coming from a non standard test configuration.

New english guide file.

Version 1.11

Modify Sample did not work

PROGRAM CHANGE event was too long

TEMPO CHANGE event was missing a byte.

SYSEX REALTIME and NON REALTIME has been added

MultiChannel samples implemented

Add the options GERMAN, ENGLISH et LATIN for the notes display
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New option LIKEWB for a Like Workbench display

Adjusted length in dialog boxes (and other cosmetic changes)

System was crashing on exit after the creation of CAMD links

Pictures instrument was not loaded correctly

Texts instrument could not be saved

Duration modification in the events window did not function on a block larger than the list entries.

Audio and Audio Drum instruments were not functionning correctly if some sounds were not assigned.

Loading and Saving of samples.

Options saving

Instruments can now be used with Metronome

Version 1.12

Expand Track function now set the pattern output channel on the new track if the original track was in Omni mode (useful for
Midifiles type 0).

Drum and Midi instruments were using the global Midi output instead of their own output.

Midifiles import was not handling correctly some MetaEvents and was not handling some Midi datas on the first track of Midifiles
type 1.

Samples default note is now C3 instead of C2 for trackers compatibility.

Tempo gadget is now ranging from 20 to 400 bpm (max theoretical limit is 72000/resolution bpm).

Tempo changes are no more moved to the beginning of their measure.

Protracker/NoiseTracker files import.

Support for Pitchbend, KeyPressure, ChannelPressure and ControlChange 10 (Pan) for audio instruments.

Effects support for patterns, tracks and song.

Metronome was not functionning correctly if tempo was not 120bpm.

Wave forms of a length greater than 65536 samples per channel are now loaded from disk.

Stereo samples are now supported.

XApp instrument has been removed.

Text documentation for those not having AmigaGuide V40.

audio.device support removed.

The ARexx command LOAD has been replaced by LOAD SONG|PATTERN|TRACK|INSTRUMENT|SOUND (Only LOAD
SOUND and LOAD SONG are actually working).

Samples file format has been modified.

Euterpe now uses the asyncio.library which is required for functionning.

Version 1.13

SMUS files import has been improved : the SONIX files are recognised with their .ss sample sounds.

Audio Play and Record in Direct-To-Disc mode.

GUI has been improved.

New option : HDCHANS for specifying how many audio channels are used by the direct-to-disc mode.

New option : HDFILE for the location of HD audio record.

Better handling of 4 color screens.

Piano display for a better handling of notes.
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Version 1.14

In the Events window, Replace function was generating a guru.

Some english musical terms were incorrects.

Recording a track without a pattern was generating enforcer hits.

Some entries of the Tracks menu were selectable even with no selected track.

In the 2D bars window, some patterns were not displayed if the length was lesser than 8 measures.

The Move Notes function of the 2D bars window was incorrect.

Miscellaneous improvements in the 2D bars window.

Audio selection now works better.

A New Amigaguide documentation is in progress.

Version 1.15

THe Installer script did not compile correctly.

Selection were not working correctly in 2D Edit Window.

The display height of samples was sometime incorrect.

The EMusic console now uses the Con-Handler instead of the console.device directly.

Use of the Ralph Babel’s WBPath routines for most AmigaDOS calls.

Inversion of the REXX RX and RXS commands for consistency with other Amiga programs (such as Wack).

When the EMusic console is opened, the standard output is redirected to it.

Miscellaneous improvements in the Audio Edition.

The system requesters now all appear on the Euterpe’s screen. sur l’écran Euterpe.

New Installer script.

Access to the joystick port (external controls and Pitch Bender) is now optional (USEGAMEPORT option).

ARexx command extension.

When the program was started from Workbench, the options of each icon were taken (instead of the first selected).

The real program name was not used when saving icons.

Version 1.16

Some instruments Edit windows has been modified.

Master tracks were created twice when loading ETSF files.

Master tracks contents were not exported in midifile format.

OUI translator files added.

Added the missing options for the functions keys, the external controls and the navigation screen.

When loading a Midifile, the METAEVENT instrument name is now assigned to the pattern name.

Tempo and signature changes has been rewrote.

UnMix pattern function has been rewrote.

SPP messages were not correctly sent.

Miscellaneous improvements in the display.

New keyboard shortcuts.

An ATO project has been started (actually deutsch and czech).

The optimized versions have now the same functionnalities than the 68000 version.
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MTC input synchro was not recognised.

Euterpe now recognise the SPP messages as input (still experimental).

Version 1.17

Added BankEditors support

Added Rythm Editor and 3D display

Graphics Interface has been modified

1.9 installer

Euterpe’s Installation

What you need to know before installing Euterpe

The software installation is simply taken in charge by Installer

A standard 3.0 system is enough for Euterpe’s operation. If you want to use Euterpe on a 2.0 system you should consult the
installation specificities.

Installation of CAMD.library is not provided by the software because I do not actually have the license for distributing this
library. Owner of the Developer CD from Amiga Technologies or Electronics Arts Deluxe Music will found this library or have
it already installed on their system. You can also download the camd.lha archive from Aminet. Euterpe will automatically detect
the presence of the CAMD and will then provide you access to its features. The 2.0 version of the CAMD.library is required
because the 1.0 is obsolete.

AHI should also be installed externally. The minimum version required is 4 and you should not try it with Euterpe if you have a
previous version installed.

If you do not own the CAMD.library, Euterpe will continue to operate normally, but will disable some specifics features.

Please note also that the online help will only function with an AmigaGuide version >= 39. Beta-testing has proven that some
users have mistakenly installed some previous versions of this library.

1.10 installer2

Euterpe Installation on a 2.0 system

For the users of the V37 and V38 of the operating system

Euterpe will not function with a standard V37 or V38 system.

Since Euterpe makes use of the realtime.library, you will need the special version of this file for the 2.0. Actually I do not have
the license rights which will allow me to distribute this file with the software. Owners of Amiga Technologies Developer CD
will find this file in the CD.

With a 2.0 system the online help has been disabled.

Some minor troubles may appear in the display. Please note that a 4 colour screen has been allowed only because of the
Productivity ECS screen mode, in fact the correct display will need at least 8 colors.

With a V37 system the locale.library is missing so the only language available will be english.

I have also recently removed the language icons of the Installer scripts, this means that under V37, the installation language
will be english, unless you add this tooltype : LANGUAGE=français in the icon. Of course, you should replace français by the
language of your choice.

This software is regularly tested on an Amiga 600 V38+ECS. Note however that most of the tests are done with a 3.0 system, so
a few problems might be unknown of me.
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1.11 smf

The Midi Files

The Midi Files are very important in the exchange of MIDI datas between different kinds of hardware and software.

The Standard MidiFile (SMF) allows the transfer of datas between different types of sequencers.

Three formats already exist :

The format 0 is single track : every datas are on a single track.

The format 1 is multi tracks : one track is dedicated to a channel and a supplementary track is created to manage the Tempo
changes.

The format 2 is multi patterns : not recognised by Euterpe.

1.12 fgm

The GM/GS/XG formats

The GM, GS and XG formats allow the recognition of sounds and instruments employed for a music part.

The General MIDI (GM) , the Roland GS and the Yamaha XG formats define a standard for the sounds used by a synthetiser
and notes for a drum kit. The GS format is an extension of the GM format from the manufacturer Roland. The XG format is an
extension of the GM format from the manufacturer Yamaha, not yet recognized by Euterpe but you can still create instruments
for your XG banks.

Euterpe knows about the GM/GS formats and allows you to know which instruments had been employed. Further more, with the
help of the Drum instrument you can also determine which DrumKit elements had been used.

1.13 options

Euterpe’s options

Euterpe does not use an option file or environment variables, but use the icons tooltypes and the command line parameters if
started from CLI.

The command line template is the following : F=FILES/M,ID=DISPLAYID/K/N,W=WIDTH/K/N,H=HEIGHT/K/N,OVERSCAN/S,D=DEPTH/K/N,
AUTOSCROLL/S,R=RESOLUTION/K/N,RSTATUS/S,U=UNDOSIZE/K/N,G=GRID/S,SOFTTHRU/S, LANG=LANGUAGE/K,TF=TEXTFONTNAME/K,TFS=TEXTFONTSIZE/K/N,SF=SCREENFONTNAME/K,
SFS=SCREENFONTSIZE/K/N,SN=SERIALNAME/K,SU=SERIALUNIT/K/N,IL=INPUTLINK/K, OL=OUTPUTLINK/K,USECAMD/S,AHICHANS/K/N,AHISOUNDS/K/N,LATIN/S,GERMAN/S,
ENGLISH/S,LIKEWB/S,ENCAPSULATE/S,HDCHANS/K/N,HDFILE/K,SR=SAMPLINGRATE/K/N, USEGAMEPORT/S,F1/K,F2/K,F3/K,F4/K,F5/K,F6/K,F7/K,F8/K,F9/K,F10/K,
EXTLMB/K,EXTMMB/K,EXTRMB/K, NS_BORDERBLANK/S,NS_BORDERNOTRANS/S,NS_BIPLANEKEY/S,NS_CHROMAKEY/S,
NS_BIPLANE/K/N,NS_CHROMAPEN/K/N,NS_ACTIVE/S,NS_TIMEPOS/S,NS_POSITION/S,NS_CONTROLS/S

/M means multiples

/S means switch (True if set, False if not)

/K means KeyWord

/N means number

= indicates a synonym. The short name cannot be used by the tooltypes.

With the tooltypes, tou specify the option name, followed by = and the contents.

Numbers are only decimal, Booleans are TRUE for true and FALSE for false. Actually all are false if not specified.

FILES

With the CLI you can enter one or more filenames which will be loaded at program start.

ID
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Indicates the screen display mode. It can be decimal, or hexadecimal (if started with 0x).

{LINE} Indicates the screens width. If the specified width is lesser than 640 pixels it will be automatically set to this value (640).

HEIGHT

Indicates the screens height. If the specified height is lesser than 200 pixels it will be automatically set to this value (200).

DEPTH

Indicates the screens depth. If the specified depth is lesser than 2 planes it will be automatically set to this value (2). You can
calculate the number of colors with by elevating 2 to the power indicated by depth.

DEPTH=2 gives 4 colors, 3 gives 8 colors, 4 gives 16 colors and so on.

AUTOSCROLL

Activate automatic scrolling of screens.

OVERSCAN

Activates the overscan mode for screens.

RESOLUTION

Internal sequencer resolution in pulses per quarter note. This value is not actually limited. Anyway the options dialog box will
propose you reasonnable values between 96 and 768 (192 is the default)

RSTATUS

Activate Running Status mode in MIDI flows

This option is not actually working

UNDOSIZE

Undo/Redo buffer size

This option is not actually working

GRID

Activates the grid. With the grid patterns are placed at the beginning of the measure.

SOFTTHRU

SOFTTHRU mode allows you to read midi events and to send them back even when the sequencer is not recording.

LANGUAGE

Indicates the language to use.

TEXTFONTNAME

Name of the fixed size font. Beware of the case differences : Topaz.font will give a different result of topaz.font

TEXTFONTSIZE

Taille de la fonte non proportionnelle. Size of the fixed-size font.

SCREENFONTNAME

Name of the proportional font.

SCREENFONTSIZE

Size of the proportional font.

SERIALNAME

Name of the serial driver (example: serial.device)

SERIALUNIT

Unit number of the serial device



Euterpe 11 / 38

INPUTLINK

Name of the CAMD input link.

OUTPUTLINK

Name of the CAMD output link.

USECAMD

Use the CAMD functions.

AHICHANS

AHI channels number

AHISOUNDS

AHI sounds number

LATIN

Latin Notation (Do Ré Mi Fa Sol La Si)

GERMAN

German Notation (C D E F G A H)

ENGLISH

English Notation (C D E F G A B)

LIKEWB

Use Workbench settings for the display

ENCAPSULATE

Not used for the moment.

HDCHANS

This option is used in combination with AHICHANS. This is the number of channels reserved for direct-to-disc. Since a single
channel costs about 192Kb, you should carefully evaluate how many channels you want to allocate.

HDFILE

This is the place where Euterpe will store direct-to-disc samples. By default it is T:. When you make your first tries with
recording, it is wise to make this location somewhere in RAM:.

SAMPLINGRATE

Not used for the moment.

USEGAMEPORT

This option is needed for those using special equipment such as a GVP GenLock already using the joystick port. Setting this
option to FALSE will disable all the external controls and the joystick pitchbend support.

F1 to F10

Macros definitions

EXTLMB, EXTMMB, EXTRMB

External controls definitions

NS_ ...

Navigation screen definitions

Examples

If you want to use AHI and a screen depth of 5 (32 colors) from the CLI

Euterpe:Euterpe USEAHI DEPTH=5
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and with ToolTypes :

USEAHI=TRUE

DEPTH=5

Workbench start

If you start Euterpe by selecting one or more icons, the options will be those of the first selected icon.

Preferences saving will only modify Euterpe:Euterpe icon. Anyway, each time you save a file, the actual preferences are stored
to its icon. So, you can create songs without events, only for keeping different configurations.

1.14 creepiste

Create a track

Each project constructed with Euterpe is formed of tracks and patterns. A track is the vertical part of a project and is useful in
the repartition of the MIDI Channels. The right part is dedicated to the patterns.

To create a track, two methods are possible :

With the mouse, by double clicking in the edition window. The track creation window will then appear.

In the EMusic window with the command :

CREATE TRACK "TrackName" where TrackName is the selected name for the track.

CREATE TRACK "TrackName" AUDIO will create an audio track.

1.15 creesection

Create a pattern

A pattern is the horizontal part of a project and its main purpose is the handling ofevents. The patterns are located on the right
part of the screen. The left part is dedicated to the tracks.

To create a pattern; three methods are allowed :

With the mouse, by double clicking in the edition window in the front of the selected track.

With the duplicate option in the Patterns menu. A copy of the current pattern will be made.

In the EMusic window, with the command :

CREATE PATTERN "PatName" where PatName is the selected name for the pattern. The pattern will be created on the current
track.

1.16 creesmf

Create a Midi File

By creating a Midi File, you will be able to transfer your projects to other sites not yet equiped with Euterpe.

To create a Midi File, you must have a project loaded in RAM then select the Export option from the Project menu and the
sub-entry MIDIFILE 0 ou MIDIFILE 1 depending on the selected type.
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1.17 enrmidi

MIDI Recording

The MIDI recording is one of the main functions of a sequencer. Before anything else you must have a MIDI source (such as
a keyboard with a MIDI OUT plug), a midi interface for your computer, and at least a cable to make the junction between the
MIDI OUT plug of your source and the MIDI IN plug of your interface.

The simplest method for recording is to create a pattern, activating it it if necessary with a mouse click. Then select the record
button in the Control window. When you will push the Play button, you will then notice that the position counters has started
moving. To stop the recording, simply push the Stop button.

1.18 enrmulti

Multitracks recording

Multitracks recording allows the recording of more than one MIDI channel at the same time.

For multitrack recording, you have to select the Record option and the input channel in the track Edit window for each desired
track. Other channels will be filtered.

1.19 enraudio

Audio Recording

Audio recording allows you to add voice and acoustic instruments to your songs. For this you will need an AHI compatible
sampler.

For recording sounds, you must create an audio track ans select this track before switching to record mode. But before this you
must set the recording speed bu the menu Edit->Audio Access then the buttons Modify and Audio Mode Selection. The sampling
rate is of great importance if your sampler is using the Amiga main processor : a too high rate could hang your machine. In all
cases you should be able to sample at 8000Hz, which is not enough for a good record quality but fine for composing or arranging
a song. Audio recording uses the same principles than Midi recording.

1.20 midi

Midi (CAMD and serial.device)

MIDI stands for Musical Instrument Digital Interface and its specifications tell how the datas are travelling between a network of
machines composing a network.

On the Amiga, this datas are generally using the serial interface and need a MIDI interface or a serial cable for linking two
Amigas. This is how Euterpe was functionning in the first time.

The actual version allows you to access as many Midi networks as you have serial ports and you can also open virtual Midi
accesses on other CAMD applications.

This Midi accesses are defined as input and output and defined by a name (e.g. : serial.device) and a unit number (0 is default
unit). The same access or a different access can be used in input and output. The accesses are used by Midi and Drum instruments
and can be edited by the menu Edit -> Midi Access. You will notice a list with a selected entry : the access which is selected is
the default one, used for the edition and other operations (such as Midi Testing) where Instruments are not taken into account.

The use of the CAMD.library will allow you to create internal accesses to transmit MIDI datas to other CAMD software or to
CAMD Midi drivers. For example, you can create a Midi access (called Cluster) that will be used as an output for Euterpe and
as an input for another CAMD software (such as a MIDI effect processor) which will then transform the datas and send them to
the MIDI interface or to another software.
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1.21 audio

Audio (AHI)

Audio with Euterpe is functionning in two ways : like a Midi instrument or as a single sample.

Euterpe being dedicated to become a full-featured software, the Audio routines constitute a big part of the application.

in the first time, this routines were based on audiotools routines of Rob Peck, which may be a little old but are still the best way
to use the audio.device.

Historically, these routines are tied to the IFF 8SVX and IFF SMUS file formats. The samples are defining octaves and an array
say which octave must be used for each of the 128 Midi notes. These samples also have an introduction part played once and a
repeat part, played again until the end of the note.

This mecanism has been greatly enhanced by the introduction of the Dissidents’s SAMP format which brings the possibility of
using resolutions from 8 to 32 bits, a varying number of channels (IFF 8SVX format is at most stereophonic) and do not define
octaves anymore but a set of waves for each of the 128 notes. This great format did not encounter much success, probably
because of it’s complexity and also because some fields are missing to make it really perfect (For example, a 435 Hz A can not
be differenciated from a 440 Hz A because the note is defined as a Midi index). Euterpe is however internally very close to the
SAMP format.

Actually, Euterpe is able of reading the following formats : IFF 8SVX and IFF AIFF. Other formats can be imported with the
DataTypes (3.0 or + needed), in this case they will be converted to IFF 8SVX (8 bits).

The new AHI system is a great enhancement concerning the number of audio channels and the sounds resolution. It’s major
advantage is the possibility to interface transparently not only the Amiga internal audio but also most of the sound cards available
on the market. With AHI, it is now possible to define a new audio format.

audio.device support has been removed because of the difficulty of implementing the double-buffered reading and also because
of the impossibility of setting volume, frequency and panoramics without accessing the hardware. Since the AHI support routines
have been greatly enhanced, the loss of quality of some 8 bits samples will be certainly be solved by a better selection of your
audio driver.

If you use AHI, then it will be possible to configure more than one Audio output with the menu Edit -> Audio Access. The
default access will be the one selected in the list.

1.22 pistemidi

Track Type : MIDI

These tracks contain MIDI events.

MIDI tracks hold notes and other Midi events. Common and Realtime messages can be edited but in other tracks. For selecting
the pattern type, press Shift and double click on the track name.

1.23 pisteaudio

Track Type : AUDIO

These tracks contain samples.

Audio samples can be used with instruments by MIDI tracks. However, in the case where these samples are only sound effects
or if their size prevents you to hold them in memory, you can choose to use them in an Audio track by creating one pattern for
each sample. This is how you will be able to replay the direct-to-disc samples.
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1.24 pistemaster

Track Type : MASTER

This track allow the control of global events.

Master track events are affecting all the other tracks.

Different from other tracks, the master track always exists and can’t be deleted. It is also unique, and the only action allowed is
edition in events mode. Actually, the master track recognise tempi and signatures changes.

1.25 dialogue

Questions and Answers

Since you may ask some questions about this software, here are some answers.

How to set the locators ?

Go to the wanted position and then simply click on the record button. Select then the locator you want to set.

What are external controls ?

Theses controls are for those of you which want to bring their Amiga on stage ! In this case a simple three buttons mouse
connected on the joystick port will allow you to control the functions of your needs. Those who have some electronic knowledge
will be able to easily make some kind of foot pedal.

What is navigation screen for ?

When a band starts a practice session, maybe one musician doesn’t know the song structure or may be the singer forgot the texts
... Navigation screen is here for introducing useful informations when the song is performing (it sure can do karaoke but this is
not my cup of tea).

This can be also be useful on stage if you want to add some visual effects to your compositions... (notice that this screen is
genlock aware)

What is OUI ?

OUI means Object User Interface. This is a collection of C++ functions designed to make GUI programming easy. A simple
dialog box is made with OUI in less than fifty lines of code. OUI has nothing to see with UIK, MUI or the others. It is even
possible to interface OUI with any of those... The (awful ;)) OUI gadgets are simply BOOPSI gadgets that I wrote to enhance
a little my interface. May be one day I will give OUI to the public domain but it is not my priority. Tell me if you want things
speeded up.

1.26 ecrans

Euterpe ’s Screens

You have probably noticed that Euterpe used two scrrens. One of them is dedicated to the windows and the other one to the
display.

The Public Screen

The main screen of Euterpe is a public and its name is Euterpe. If the application is quitting and if windows that do not depend
of the application (known as visitor windows) are still there, Euterpe will ask you to close them. If the windows are still present
after that, Euterpe will free everything but will let the screen opened. If later, you load again Euterpe then the application will
use this screen instead of creating another one.

The Navigation Screen

The text display is made on a so called Navigation screen which is also used by external controls. If you select the Navigation
screen active option this screen will pass in the foreground at each play and then to the background at each stop. If the option
inactive the screen will stay in the background.
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Other screens

If you are displaying pictures, Euterpe will load them in a separate screen. This one will be closed at the end of the display. If
your pictures do not display, it is possible that there is not enough memory left for a new screen initialisation.

1.27 farplan

The background window

This window allows you to regain the control of the software when you have closed all other windows.

This window does not contain any gadget but allows a limited menu selection when it is activated :

Project -- Files operations

Windows -- Windows selection

1.28 fpistes

The tracks window

Tracks and patterns edition window.

The leftmost part of this window contains four rectangles :

» Inside the first is the track name. At startup, this box is empty since no visible track has been created.

Tracks types

The tracks may be of three kinds : Midi, Audio or Master .

Master Track

The Master track is unique and invisible. You can access to it via the Edit menu.

Track selection

This is done by a click on the left mouse button while pointing on the track name.

Multi-selection of tracks

Same type tracks can be selected simulteanously by keeping the SHIFT key pressed while selecting them. The active track is the
first selected.

Moving the active track

You can move it by keeping the left mouse button pressed and dragging it vertically to its new position.

Accessing Tracks menu

You can access to the Tracks menu if the active track exists. Some operations work on all selected tracks.

Tracks parameters

By double-clicking on a track, you will make appear the parameters window of this track.

» The second box contains the name of the instrument used by the track.

» The third box contains the input (in black) and output (in white) channels of the track. If a channel is displayed as Omni the
patterns channels will be used.

» The last box contains three buttons : M, R et FX.

The M button

This button activates/deactivates the track output (Mute).

The R button
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This button activate/deactivate the record.

The FX button

This button activate/deactivate the effects

The rightmost part is used for creation and edition of patterns.

Patterns types

Master and Audio tracks allow only one pattern type. Instrument tracks allow three different pattern types : Channel, Common
and SysEx. You can modify the pattern type by selecting the track parameters.

Pattern selection

Click on the pattern with the left mouse button.

Multi-selection of patterns

Patterns of the same kind can be selected simulteanously by keeping the SHIFT key pressed during the selection. The active
pattern is the first selected.

Moving the active pattern

You can move it by holding the left mouse button pressed and by dragging it horizontally.

Changing track

Track change is done by dragging the pattern vertically.

Accessing the patterns menus

You can access to the Patterns menu if the active pattern exists. Some operations work on all selected patterns.

Pattern edition

By double-clicking on a section, you will make appear the Edition window of this pattern.

Pattern parameters

By keeping the SHIFT key pressed and double-clicking on a pattern, you will make apperar the parameters window of this
pattern.

Above the patterns are drawed the graphical indicators : measure numbers and the two locators.

In the bottom of the window is the status bar : Euterpe will display some messages in this place.

Two scrollers (horizontal and vertical) are on the window borders. They allow to move between tracks (vertical scroller) or
between measures (horizontal scroller).

From this window, you may access to the following menus :

Project -- Files operations

Windows -- Windows selection

Edit -- Accessing datas

Tracks -- Tracks operations

Patterns -- Patterns operations

Preferences -- Euterpe’s Configuration

Macros -- Repeating actions

MIDI Control -- MIDI tests ad access
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1.29 fcreepiste

Track creation window

This window allows to set up the initial parameters of a track

This track creation window contains :

Name input

This gadget allows you to define a name for the new track.

Type selection

Choose Instruments for a Midi track and et Samples for an Audio Track.

Inputs/Outputs

These two display zones show you the capacities of the instrument or the AHI driver you have selected.

Instruments list

You may choose the instrument for this track from the list.

OK/Annule

Validate (OK) or cancel the creation by clicking on the matching button.

1.30 fparapiste

Track parameters window

This window allows the setting of the parameters of a track.

This window contains :

Name entry

Enter the new track name in this gadget.

Pattern type selection

Instruments tracks allow three patterns types : Channel, Common and SysEx.

Channel

The patterns of this kind are the more frequently employed and contain events associated with a Midi channel (Note, Program
Change, etc...).

Common

These patterns are seldom used and access all channels simulteanously (Song Pointer Position, TuneRequest, ...).

SysEx

SysEx patterns contain System Exclusive events and may address all or a single channel depending on their format. The SysEx
($F0) and EOX ($F7) events are defined here plus one Data event. However, to help you in the edition of System Exclusive datas,
Euterpe recognise some special codes defined by the Midi protocol such as Constructor (constructor ID) and RealTime and Non
RealTime events which are employed by some protocols such as General Midi, Midi Show Control or Midi Machine Control.

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.
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1.31 fparasection

Pattern parameters window

This window allow the setting of the parameters of a pattern.

Window contents:

Pattern Name

Enter the new pattern name in this gadget.

Channell

Outut channel used by the pattern.

Volume

Output volume (Audio patterns only)

Wave

Wave form selection (Audio patterns only)

Starting Measure/Time/Step

Starting position of the pattern.

Samples

List of available samples (Audio patterns only).

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.32 finstruments

Instruments edition window

This window allow the creation, the modification or the removal of an instrument.

Window contents:

Create

This button allows the creation of a new instrument of the same kind than the one currently selected in the list. The parameters
window will be then displayed.

Modify

This button allow the edition of the selected instrument by displaying the parameters window.

Remove

This button allows to remove the selected instrument. The linked instruments (those used by tracks) and the first instrument are
not removable.

Select the new instrument for the track in the list.

OK/Cancel

Validate (OK) or cancel the new selection by clicking on the matching button.
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1.33 fparainst

Instrument parameters window

This window allows to define the parameters of an instrument.

Window contents:

Instrument name

Enter the instrument name in this gadget.

Metronome

If this option is checked, then the instrument can ne used by the metronome.

Display

The tracks and patterns using this instrument will be drawed with the selected color.

Type

Instrument type selection between : Midi, Drum, Audio , Drum Audio, Texts, Pictures and ARexx. Changing an instrument type
will cancel all the settings you can have defined with the previous type.

Load

Load an instrument from disk.

Save

The isntrument parameters are saved on disk.

Edite

Instrument’s specific parameters are displayed. Those are depending on the type.

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.34 fmidi

MIDI instrument parameters window

This window allows to define the parameters of a MIDI instrument.

Window contents:

Program name

The program changes can be renamed with this gadget.

Instruments

List of the program changes. By default, these are the General Midi definitions.

Input

This list is for the selection of the MIDI input.

Output

This list is for the selection of the MIDI output.

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.
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1.35 frythmique

Drum instrument parameters window

This window allows you to define the parameters of a Drum instrument.

Window contents:

The Piano

The note displayed in yellow is the actually edited note. The entire Midi range is accessible (from C-2 to G 8). For editing
another note, click on the desired place. If you are not accustomed in piano note reading, each octave is formed by five black
notes (the sharps) and seven white notes. The leftmost note on the piano is C-2.

Instruments

This is the list of the drum elements compatible with General Midi and Roland GS formats. Some old drum sequencers do not
match these standards, you will need to convert your datas in some way. If possible, you should modify the drum sequencer
settings, so you will have to do the job only once.

Note

Note matching the selected element. For example, if the bass drum of your drum sequencer is assigned to the note 44, you should
set this value for the General Midi elements Bass Drum 1 (36) and Acoustic Bass Drum (35). So you will recognise this element
in the Events window.

Input

This list is for the selection of the MIDI input.

Output

This list is for the selection of the MIDI output.

Apply

Will convert automatically all the patterns using this instrument. So, in the precedent example, and if you have loaded a General
Midi file, all the notes 35 and 36 will be changed to 44 if you click on apply. si vous sélectionnez le bouton Applique.

OK/Cancel{ub}

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.36 faudio

Audio instrument parameters window

This window allows you to define the parameters of an Audio instrument.

Window contents:

Program

Program change number between 0 and 127.

Edit

Edition of the sample assigned to the selected program.

Clear

Clear the links of the slected program.

Sounds

Selection of the sample assigned to the selected program.

Audio driver

List of the AHI drivers availables

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.
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1.37 frythmiqueaudio

Audio drum instrument parameters window

This window allows you to define the parameters of an Audio Drum instrument.

Window contents:

Note

Note selection.

Edit

Edit the sample assigned to the selected note.

Clear

Remove the link between the note and the sample.

List

List of GM/GS drum elements.

Sounds

List of samples.

Audio output

Name of the AHI driver.

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.38 ftextes

Texts instrument parameters window

This window allows you to define the parameters of a Text instrument.

Window contents:

Piano

The note displayed in yellow is the actually edited note. The entire Midi range is accessible (from C-2 to G 8). For editing
another note, click on the desired place. If you are not accustomed in piano note reading, each octave is formed by five black
notes (the sharps) and seven white notes. The leftmost note on the piano is C-2.

Sentence

Text assigned to the note.

Note

The numerical value of the selected note on the piano.

Sentences list

Sentence selection.

Position

By clicking on the button, the Navigation screen will be displayed and the new position of the text on the screen can be set by
dragging the mouse. Press left mouse button, move the mouse and release the button for a new posisition. If you don’t want to
set a new position then press right mouse button.

X Position and Y Position
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This gadgets provide another way of entering the position.

Font

A font requester will appear on the navigation screen if you select this button.

OK/Annule

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.39 fimages

Pictures instrument parameters window

This window allows to define the parameters of a Pictures instrument.

Window contents :

Piano

The note displayed in yellow is the actually edited note. The entire Midi range is accessible (from C-2 to G 8). For editing
another note, click on the desired place. If you are not accustomed in piano note reading, each octave is formed by five black
notes (the sharps) and seven white notes. The leftmost note on the piano is C-2.

Picture

Access path for the selected picture.

Note

The numerical value of the selected note on the piano.

File Request

Allows to load a picture from the disk.

Display

The picture will be shown on a separate screen.

Pictures list

The picture selection can be done on this list.

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.40 farexx

ARexx instrument parameters window

This window allows you to define the parameters of an ARexx instrument.

Window contents:

Piano

The note displayed in yellow is the actually edited note. The entire Midi range is accessible (from C-2 to G 8). For editing
another note, click on the desired place. If you are not accustomed in piano note reading, each octave is formed by five black
notes (the sharps) and seven white notes. The leftmost note on the piano is C-2.

ARexx File

Access path for the selected ARexx script.

Note
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The numerical value of the selected note on the piano.

File Request

Allows to load an ARexx script from the disk.

Launch

Execute the selected ARexx script.

Scripts list

The script selection can be done on this list.

OK/Cancel

Validate (OK) or cancel the new parameters by clicking on the matching button.

1.41 fcontrole

The control window

This window contains the gadgets needed for recording, playing and moving into a project.

On the first line, from left to right:

Record

This button activates the record mode. This mode allows you to record if you press the Play butto, to set the locators to the
current position if you click on one of them and also to insert tempi changes in the Master track if you move the tempo gadget.

Play

By pressing this button, you enter in the Play mode. If the Record mode is set then you will be effectively recording. If the Loop
mode is set, the starting point will be the left locator and the reproduction will progress until the right locator is reached and then
the song will start again from the left locator and so on. If the Insertion mode is set, the song will play normally but the record
mode will be activated between the left and the right locator positions.

Beginning

The start of the song is reached.

Fast Rewind

The position goes backward until the start of song is reached.

Fast Forward

The position goes forward.

End

The real end of the song is reached (the last event position).

Stop

Stop Play and Record. The Record mode will be unset if necessary. si nécessaire.

Pause

Performs a real pause. The sounds generators are not stopped, time is suspended until you release the pause. This is very handy
when you want to do some settings on your sounds.

Left Locator

When clicking on this button, the song pointer will move to the left locator position. If the record mode is active, the left locator
will be set to the current position. The screen will flash if the setting is incorrect (left position > right position).

Right Locator
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When clicking on this button, the song pointer will move to the right locator position. If the record mode is activen the right
locator will be set to the current position. The screen will flash if the setting is incorrect (right position < left position).

Solo

The mute (M) button of each track is inverted when you press this.

Loop

Activate the Looping mode : the song position will cycle between the two locators.

Insertion

Also known as punchin/punchout : the record mode will be activated at the position specified by the left locator an deactivated at
the rght locator position.

Time Signature

This button is not active yet.

On the second line, from left to right:

Tempo

This slider allows to set tempo and insert tempi changes in the Master track if the record is active.

Position

Display the actual position in Measure/Time/Step

Time position

Display the SMPTE time value of the position in Hour/Minute/Second/Video Frame.

Left locator

Display the left locator position in Measure/Time/Step

Locateur droit

Display the right locator position in Measure/Time/Step

From this window, you may access to the following menus :

Project -- Files operations

Windows -- Windows selection

Edit -- Accessing datas

Tracks -- Tracks operations

Patterns -- Patterns operations

Preferences -- Euterpe’s Configuration

Macros -- Repeating actions

MIDI Control -- MIDI tests ad access

1.42 femusic

EMusic Console

In this window, you can perform directly ARexx commands.

The aim of this window is to help you in the handling of the ARexx commands by trying it. The HELP command will show you
the list.
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1.43 feditsection

Patterns edition windows

These windows provide patterns editing features.

The patterns only work on a single output channel. The access to the edition windows is gained by double-clicking on the selected
pattern. Each kind of window has an associated edition mode which is memorized. At each time, during the edition you may
switch to another kind of edition depending on your needs. Master type patterns can only be edited by the Events window.

The edition windows actually handled by Euterpe are :

2D Edit -- 2D graphical edition

Events -- List edition

1.44 f2d

The 2D bars edition window

This window display the pattern contents in two dimensions.

Window contents:

Display box

Onto this box the events are drawed. The upper part is used for the general display and the lower part is used for the velocities.
The measures are indicated between this two parts.

Zoom box

The place where the mouse is pointing at is reproduced and enlarged in this box. The red caret indicates the exact pointer position.
Thus, in case of difficulties in selecting events, looking into this box may help you.

Insertion

Click on the brush for entering insertion mode. You will then insert events by drawing them. The status bar will give you the
parameters of the newly created event.

Removing

Click on the rubber for entering removal mode. You will then delete events by clicking on them. This operation can’t be undone
but you still have the possibility of closing the window and restore the previous pattern by answering "No" to the asked question.

Length

Click on this button for modifying a note length. Then click on the note and set its new length.

Move

Click on this button for moving an event. Click on the event and move it horizontally for a new pos and vertically for a new note
value.

Selection

Click on this button for selecting events. With the mouse, you will select all events between the place where you click and the
place where you released.

Play

The contents of the screen will be played by clicking on this button.

Type selection

The event type is selected. Available types are depending on the pattern type.

Status bar

This is wher the event parameters are displayed.
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Scrolling bar

This bar allows you to move into the pattern..

From this window, you may access to the following menus :

Windows -- Windows selection

Display -- Display control

1.45 fevents

The list edition window

This window display the list of the patterns events.

Window contents Insert

Click on this button for inserting a new event in the list. The event type will be displayed by the type gadget. If a new event is
already selected, the values of the new event will be taken from it. Else, default values will be used.

Remove

Click on this button for removing all the selected events.

Type selection

The active (first selected) event type can be modified with this gadget.

Attributes

This three gadgets are for the setting of the contents of the active event.

Position

This three gadgets are for the setting of the position of the active event.

Duration

This three gadgets are for the setting of the length of all selected events.

List

The events are displayed here.

Scroller

This gaget is for moving into the list.

From this window, you may access to the following menus:

Edit -- Events edition

Action -- Searching and replacing

Windows -- Windows selection

1.46 mprojet

Project Menu

This menu holds the general functions of the software.

New

Create a new file.

Open
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Load a file. The file format is automatically recognised between the following :

- ETSF : Proprietary format (EuTerpe Sequencer File)

- SMF : Standard MidiFile type 0 ou 1

- SMUS : IFF SMUS format

Save

Save a song in the ETSF Euterpe format

Save as

Rename a song

Export

allow the exportation in the following formats :

MidiFile Type 0 : Mono track Midi File Format

MidiFile Type 1 : Multi Track Midi File Format

Quit

End of the application and of the public screen Euterpe if no visitor window is still present. Else the screen will stay open and
will be use in any next launching of Euterpe.

Information

Display the version number and your coordinates.

Help

Call AmigaGuide and display the Euterpe’s help

1.47 mfenetres

Windows Menu

This menu exists on all opened windows other than dialog box and allows you to make active or open the selected window.

Tracks

The tracks and patterns edit window

Control

The tapedeck type controls

EMusic Console

Open the EMusic console for command line interfacing.

Files

Display the name of each song currently available and makes active the one selected.

1.48 mpistes

Tracks Menu

This menu holds the tracks control functions

Open

Load a track
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Save

Save a track

Remove

Remove the current track

Duplicate

Make a clone of the current track

Erase

Erase everything into the track

Mix

Mix the events of the selected tracks into a new one (multi-select is SHIFT + left mouse button)

Expand

Each section is placed on a single track

Play

Play the track alone

First Pattern

Move the position pointer to the first pattern of the track

1.49 msections

Patterns Menu

This menu holds the patterns control functions

Open

Loads a pattern

Save

Save the current pattern

Remove

Remove the current pattern from the track

Edit

Edit the current pattern

Duplicate

Makes one or more copies of the current pattern

Erase

Remove all the events from the current pattern

Mix

Mix two or more sections (multi-select is SHIFT + left mouse button)

UnMix

Create sections from the current one

Play

Play the current section
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Quantify

Open the quantifying window

Effects

Open the effects window

Front

In case of many patterns at the same place, display the current section in front of the others

Back

In case of many patterns at the same place, display the current section in back of the others

1.50 mediter

Edit Menu

This menu holds the edit functions.

Cut

Remove the selection and place it into the clipboard.

Copy

Place the selection into the clipboard

Paste

Insert the clipboard contents

Master Track

Allows you to edit various parameters such as tempi and time signatures changes

Midi Access

Allows you to edit access to the MIDI outputs via serial port or CAMD.library

Audio Access

Allows you to edit access to the audio outputs via internal routines or AHI functions

Samples

Samples editing

MidiMix

Fenêtre de mixage du volume et des panoramiques pour les 16 canaux Midi.

Undo

Cancel the last operation

Redo

Restore the last canceled operation

1.51 mpreferences

Preferences Menu

This menu contains the software configuration options

External controls
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Edit the external controls for the current song

Workbench

Open/Close the Workbench

Display

Choose the screen mode

Navigation screen

Genlocks controls for the play screen

CLI

Launch a CLI process on Euterpe’s screen

Options

Differents setting such as the grid and the resolution

Save

Save the options

Load

Load an option file

1.52 mmacros

Macro Menu

This menu hold the operations on macros.

Record

Record the application events into a macro

Edit

Select and edit a macro

Execute

Execute a macro

Open

Open a macro from disk

Save

Save a macro on disk

Function keys

Assign function keys to macros

1.53 mcontrol

Midi Control Menu

This menu contains the synchronisation, test and control MIDI functions

Omni On

Send an Omni On message on the active midi channel



Euterpe 32 / 38

Omni Off

Send an Omni Off message on the active midi channel

Mono On

Send an Mono On message on the active midi channel

Poly On

Send an Poly On message on the active midi channel

Program Change

Send an Program Change message on the active midi channel

Song Selection

Send a Song Select message

Song Pointer Position

Send a Song Pointer Position message

Metronome

Metronome Settings

Input Clock

Select the clock type

Internal

Amiga timer is used

LTC Audio Time Code

Audio Informations from a sampler are used as time basis (SMPTE/LTC type)

Midi Time Code

Use an external Midi Time Code

Midi Clock

Midi Clocks are used as time basis

Aux Input

Pulses from one of the two mouse/joystick ports are taken as time basis

Output Clock

Select the kind of synchro for output

None

No synchro is sent

Midi Time Code

Midi Time Code

Midi Clocks

Midi Time Clocks

LTC Audio Time Code

Audio signal to record on a magnetophone

Midi Testing

Différents tests pour vérifier que votre configuration MIDI fonctionne

Notes On/Off
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Envoie des notes sur les différents canaux midi

Program Changes

Send program changes on the differents midi channels

Bank Select

Send BANK SELECT messages on the differents midi channels

1.54 mfenetresed

Windows menu (Edition)

This menu is for switching to another window. If the requested window is actually closed, it will be then opened.

Tracks

Display the la Track window.

Contrôles

Display the la Control window.

EMusic Console

Display the la EMusic console.

1.55 maffichage2d

The Display menu (2D Edit)

This menu holds the display options of the window.

Screen

Allows you to select another kind of edition.

Display All.

If this option is checked, all the events will be showed. Else, only the selected type will be visible.

Width

Modifies the width of 4/4 measure. Please note that if you have modified the time signature (i.e. 3/4) the actual number of
measures displayed will be different.

1.56 mediterevents

The Edit Menu (Events)

This menu holds the standard edition functions of the pattern.

Screen

Allows you to select another kind of edition.

Cut

Remove and memorize the selection.

Copy

Memorize the selection.
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Paste

Insert the memorized events.

Select All

The entire list is selected.

Undo

Not active yet

Redo

Not active yet

1.57 mactionevents

The Action menu (Events)

This menu holds the special edition functions of the pattern.

Search

Search an event by its type and its contents. The first event founded starting from the selection will become the active event. If
no event is selected in the list then the search will start again at the beginning.

Search Next

Search the next matching event and select it.

Search Previous

Search the previous matching event and select it.

Replace

Performs a search and then a replace regarding the type and the contents (only the checked boxes values will be actually searched
for or used for the replacement).

Replace Next

Replace the selected event if it is matching then search the following.

Replace Previous

Replace the selected event if it is matching then search the previous one.

Replace All

Performs a Replace Next until the end of the list is reached.

Arpegiator

When you select two or more events, their position will be set as indicated in the dialog box.

1.58 arexx

ARexx functions

The ARexx port is entitled Euterpe. There is a distinction between the use of ARexx with the capability of defining an ARexx
instrument which will execute ARexx scripts during the play. Some of these functions are available under external control.

CREATE INSTRUMENT "InstName" [MIDI|DRUM|AUDIO|AUDIODRUM|PICTURE|REXX|TEXT]

Create a new instrument. Default type is MIDI.

CREATE PATTERN "PatName" [TRACK "TrackName"]
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Create a pattern

CREATE TRACK "TrackName" [AUDIO|INSTRUMENT ["InstName"]] [INPUT channel] [OUTPUT channel]

Create a new track.

CREATE TRACK "MyTrack" creates the track "MyTrack" as an INSTRUMENT track.

CREATE TRACK "MyTrack" AUDIO creates the track "MyTrack" as an AUDIO track.

CREATE TRACK "MyTrack" INSTRUMENT "Drum" creates the track "MyTrack" as an INSTRUMENT track and use the
"Drum" instrument.

CREATE TRACK "MyTrack" INPUT 10 OUTPUT 5 creates the track "MyTrack" with the input channel 10 and the output
channel 5.

DELETE TRACK "TrackName"

Delete the named track.

ED "NomFic"

Edit the file FileName (Actually uses C:Ed or the editor defined by the EDITOR environment variable).

HELP

Display the online help.

ID = val

Store val into the variable id.

INP n

Read n datas on the MIDI input.

INSERT CONTROLCHANGE v1 v2 [PATTERN "PatName"] [POS position]

INSERT NOTE v1 v2 v3 [LENGTH len][PATTERN "PatName"] [POS position]

INSERT PROGRAMCHANGE v1 [PATTERN "PatName"] [POS position]

Events insertion

LOAD INSTRUMENT "InstName"

Load an instrument

LOAD PATTERN "PatternName"

Load a pattern

LOAD SONG "FileName"

Load a project

LOAD SOUND "SampleFile"

Load a sample.

LOCATION

Return the actual position.

LOCATION "mmm:tt:ppp"

Set the song position at mmm:tt:ppp.

NEW

Create a new project.

OUT val,val...

Send datas to the MIDI output.
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PRINT expr

Display the result of the expr expression.

QUIT

Quit Euterpe.

RECORD

Record active.

RX "FileName"

Start an ARexx script.

RXS "command"

Start an ARexx command.

SAVE

Save

SAVEAS "FileName"

Save as

SELECT PATTERN "PatName" [TRACK "TrackName"]

Select a pattern.

SELECT TRACK "TrackName"

Select a track.

SELECT WINDOW TRACKS|CONTROLS

Display the selected window.

START

Start playing.

STARTSTOP

Stop if playing, start if stopped.

STOP

Stop

SYSTEM "command"

Start an AmigaDos command.

VAR varname

Define varname as a new variable.

WAITINP

Wait the end of the INP command.

1.59 clavier

The keyboard shortcuts

Here are the Euterpe functions that you can access with the keyboard.

In the tracks window or in the navigation screen, press on the space bar for the Start/Stop function.
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In the tracks window, B allow the edition of the selected pattern with Bars and E with Events. Please note that a side effect will
allow you to edit the samples with Events or Bars. This is harmless but also useless.

In the track window, the cursor keys up and down will allow you to change the selected track and left and right are for the pattern
changes.

The following keys are also recognised :

M : to activate/deactivate a track

R : to activate/deactivate the recording of a track

F : to activate/deactivate the effects of a track

b : to go to the beginning of a song

e : to go to the end of a song

< : for a fast rewind

> : for a fast forward

l : left locator

r : right locator

j : jump to next song (loop)

1.60 inst

Euterpe’s instruments

Euterpe offer you a big instruments palette. Eight instrument types are defined. Each instrument track use only one instrument
but one instrument can be used by more than one track.

Instruments are :

MIDI

MIDI instrument is the one by default. The notes are send to the Midi output. This instrument use the General MIDI/Roland GS
definitions for the program changes but you can modify these.0

DRUM

DRUM instrument is like MIDI but is specially adapted to rythm machines. The drum notes of the GM/GS format are used but
you can modify those to your configuration and also make notes conversion.

AUDIO

AUDIO instrument is very like the MIDI one except that it use up to 128 audio sounds which are controlled by Program Changes.

AUDIO DRUM

AUDIO DRUM instrument is very like the DRUM one except that it use up to 128 audio sounds which are mapped to the Midi
notes.

TEXTS

Up to 128 text strings are definable with a font and a position for each of this texts. These strings are mapped to the Midi Notes.

Pictures

Up to 128 IFF ILBM pictures can be selected and mapped to the 128 MIDI notes. DataTypes are used if available.

AREXX

AREXX instrument allow to assign up to 128 ARexx scripts to the Midi notes.
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1.61 midiactif

Active MIDI channel

The active MIDI channel is the channel of the selected track, or if no track has been selected this channel do not exist. If the
selected track has been put in Omni mode then the MIDI active channel will be the MIDI channel of the first selected pattern.

1.62 index

ARexx Keyboard

Euterpe Menus

Instruments
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